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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in October 2023

Sector Indices vs HSI / HSCEI

CES120 vs China Theme Indices

Index Name Index Name

|

HSCEI -4.7%
CSI 300 Index -3.2%
CES120 Ind -4.19
HS Mainland 2.7% e A _
Banks Index . 170
: % Change % Change
Equity Index Futures Access Codes ’ g
Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv O0#HMBI: O0#HCHH: O#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg

As at 31 October 2023
Information for reference only
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Equity Index Futures & Options

Hang Seng Index (HSI) Futures & Options

HSI Products

(2023 vs 2022)

HSI Futures 143,434 (-6%)

Mini-HSI Futures 97,150 (-10%)

HSI Options 24,234 (-6%)

Mini-HSI Options 13,418 (+8%)

HSI Futures

. 4, +57%
Options 096 (+57%)

HSI Volatility 00)
Index Futures

HSI Dividend
Point Index
Futures

107 (+269%)

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 October 2023

X

149,607 (+31%)

21,140 (+79%)

129,380 (+19%)

19,976 (+48%)

59,229 (+12%)

0()

9,521 (+2866%)

Av erage Daily Volume
(No. of Contracts)
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120,000
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40,000 -

Av erage Daily Volume
(No. of Contracts)
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HSI Futures (YoY)

Open Interest
(No. of Contracts)

mmm ADV (L-Axis) - 200,000
Open Interest (R-Axis)

- 150,000

- 100,000

- 50,000

HSI Futures (MoM)

Open Interest
(No. of Contracts)

_ 'mmmmm ADV (L-Axis) ,
Open Interest (R-AXxis)
I - I - 150,000
) Tl
1 - 100,000
1 - 50,000
-> [ > 0
Qlc S82EST2220
2858224333238
2022 2023

HSI Options (YoY)

Open Interest
(No. of Contracts)

Av erage Daily Volume
(No. of Contracts)

,000 - ADV (L-Axis) - 400,000
Open Interest (R-Axis)
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description . : . 110 -
liquid stocks listed in Hong Kong 217 ——HSI ——VHSI r32 e==HS| Index =~ = Tencent

Index Level 17,112.48 (As at 31 Oct 2023) ;S.?C glAb

20 A 100 - eituan aba
Index Volatility (30-Day Historical) | 27.0 L o8 o

19 - ' A
Index Avg. Day High-Low Range 197.14 (Oct 2023) 90 - \ A
HSCH Correlation (2023) 0.986 181 o4 A

80 A
17

Hang Seng Index Futures

16 T : 20 70
o Aug-23  Sep-23  Oct-23 Aug-23 Sep-23 Oct-23
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.86Mn (As at 31 Oct 2023) Distribution of HSI Index Options Ol in Month-end
Call Put
: 38.0
Transaction Cost* 38.0 -
s N, g S
tamp Duty A 8 <310
3 310 3
Trading Fee HK$10 / contract S_:) &
Q 240 £ 240
SFC Levy HK$0.54 / contract = @
a 5
Commission Rate Negotiable é 17.0 2170
£
Margin as of 30 Oct 2023 HK$58,850
10.0 | . . . . ) 10.0 . . . . )
0 1 2 3 4 5 0 1 2 3 4 5
Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 October 2023
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY) HSCEI Options (YoY)
HSCEI Products or*

ADV
(2023 vs 2022) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-AXis) - 700,000 120,000 + ADV (L-Axis) - 2,800,000
Open Interest (R-Axi Open Interest (R-AXis)
i - 600,000 i - 2,400,000
HSCEI Futures 193,940 (+6%) 602,555 (-1%) 200000 100,000
160.000 - - 500,000 80.000 - - 2,000,000
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 -
Fut SIS 10,535 (-23%) 5,673 (+12%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - 0 0 L e e e e e e 0
N N D O A9 NS
. ) S S S S S S
HSCEI Options 48,553 (+8%) 1,329,922 (+16%) v
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mini HSCEI 3,779 (+8%) 28,513 (+2%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-AxiS) - 700,000 80,000 - ADV (L-Axis) - 2,000,000

220,000 Open Interest (R-Axis) | 600,000 Open Interest (R-AXis)
HSCEI Futures | 500000 60,0007 [ 1500000
. 35,536 (+83%) 1,097,453 (+49%) 165,000 - i
Options 400,000
40,000 - - 1,000,000
110,000 - - 300,000
- - 200,000
HSCEI Dividend 55,000 - 20,000 - - 500,000
Point Index 1,298 (-5%) 85,256 (+48%) - 100,000
Futures L N P —— 0 0
2ogB888853988 >olcagss>cs ooy
20fL=T237260 $85822253238
P02 2023 202 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 October 2023
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

. Comprises the largest and
Index Description . 108 -
most liquid H shares HSI HSCEI
Index Level 5,861.74 (As at 31 Oct 2023) 106 -
Index Volatility (30-Day Historical) | 30.6 104 -
Index Avg. Day High-Low Range 73.16 (Oct 2023) 102 -
Correlation with HSI, CES120 (2023)| 0.986,0.935 100 -
Correlation with CSI300, FTSE A50 0.731,0.733 98 -
(2023)
96 T T T r
3-Oct 10-Oct 17-Oct 24-Oct 31-Oct

HSCEI & Top 5 Constituents

1209 _hscel —— Ping An
Tencent = CCB

110 - Meituan Baba
100 -

90 -

80 -

70

Aug-23 Sep-23 Oct-23

Distribution of HSCEI Index Options Ol in Month-end

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.29Mn (As at 31 Oct 2023) Call
14.0
: g
Transaction Cost* g 120
¢ 10.0
Stam p Duty N/A b
o 80
q v
Trading Fee HK$3.5 / contract =
» 6.0
x
SFC Levy HK$0.54 / contract %é 4.0
Commission Rate Negotiable 20
0 10 20 30 40 50 60 70
Margin as of 30 Oct 2023 HK$24,500 Open Interest ('000)

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 October 2023

X

Put

0 20 40 60
Open Interest ('000)



Weekly HSI & HSCEI Options Performance
Weekly HS| Options

Contract Multiplier HK$50 }’,\‘,’g‘_‘g‘f@mmﬂs)
Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver 30,000 - ® Weekly HSI Options
25000 - m Weekly HSCEI Options
Transaction Cost* 20,000 -
Stamp Duty N/A 15,000 -
Trading Fee HK$10 / contract 10,000 -
SFC Levy HK$0.54 / contract 5,000 -
Commission Rate Negotiable O_oooooooooooooooooooo
= A A A A A
F I PO TSIV HORNDDSITWON S o
I d A A1 N NN NNOOMm
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 12,000 - ==\ eekly HS| & HSCEI Options Call
L . . . == \\eekly HS| & HSCEI Options Put
Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver y P
8,000 -
Transaction Cost*
Stamp Duty N/A 4,000 -
Trading Fee HK$3.5 / contract
0 T T T T T T T T T T T T T T T T T T T
SFC Levy HK$0.54 / contract O 0O 0O 0000000000000 O0 OO0 O O
dddddddddddddddddddd
Commission Rate Negotiable OFTWOIgITYIZITI2IRILELRES

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 October 2023
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2023 vs 2022) _— No. of Single Stock Derivatives

Stock Futures 6,994 (-11%)

Stock Options 651,154 (+11%)

Stock Futures (YoY)

Av erage Daily Volume
(No. of Contracts)

Stock Options (YoY)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

12,000 - mmmm ADV (L-AXis) - 40,000 800,000 - ADV (L-Axis) -
10.000 - Open Interest (R-Axis - 35,000 Open Interest (R-Axis)/f |
' - 30,000 600,000 -
8,000 1 - 25,000 i
6,000 - - 20,000 400,000 - -
J - 15,000 L
4,000 - 10,000 200,000 -
2,000 el I - 5,000
LR -0 0 & Bttty b L L
NOO L0 N O S
DN N N R

Stock Options (MoM)

Stock Futures (MoM)

Open Interest Average Daily Volume
(No. of Contracts) (No. of Contracts)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

10,000 1 _glst\a/n(lLr;tAeXrEs)t (R-Axis) [ 40000 800,000 gl;;/n(:_-A;iess)t (R-Axis)
8.0007 30,000 600,000 \/_)\/\/
n | 20,000 400,000 -

4,000 -
2,000 - | 10,000 200,000 -
01 -0 0 oo oo
285882853558 5858282853358
2022 2023 2022 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 October 2023

X

32,763 (-4%) Single Stock Futures
10,945,598 (+42%) Single Stock Options

126

Latest and Future Developments

Open Interest
(No. of Contracts)

10,000,000

8,000,000 * Products

6,000,000 » 3 A-shares ETFs futures contracts
4,000,000 > Total 98 stock futures contracts
2,000,000

0

Stock Options

Products
» 3 A-shares ETFs options contracts

r 12,000,000 » Total 126 stock options contracts

- 8,000,000 * Market Makers (MMs)
» 3 types of market makers (PMM/ CQMM/
QRMM)

- 4,000,000 . . .
» CQMM to provide 50 series continuous
guotations

0



Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 31 October 2023)

e Tracks the largest technology companies
Index Description . .
listed in Hong Kong

Hang Seng TECH Index Futures & Options & Futures Options
HK$50 per index point

HK$188K (As at 31 October 2023)
Options: 5

Contract Multiplier

Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*

Stam p Duty N/A
Trading Fee HK$5.00 / contract
SFC Levy HK$0.54 / contract

Providing investors with a tool to manage their risk exposure
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 October 2023

Open Interest
(No. of Contracts)

400,000 -
300,000 -
200,000 -

100,000 -

0

> O c Q P 5 > £ S o o 3
2 a8 ¢ =< 23> 3 & 0O
2022 | 2023 |

Average Daily Volume (as of October 2023)
A\ .'

(No. of Contracts)

140,000 -
120,000
100,000
80,000
60,000
40,000
20,000
0

> Q
[©] ()

Z 0O
2022

2023

Volume and Open Interest continue to growth

10



MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of October 2023)

. Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
(No. of Contracts)
Index Level 1,900.10 (As at 31 October 2023) 20.000 -
Index Volatility (30-Day Historical) | 15.9
15,000 -
Index Avg. Day High-Low Range 19.12 (October 2023)
10,000
CSI300 Correlation (2023) 0.963
. 5,000
FTSE A50 Correlation (2023) 0.976
0
MSCI China A 50 Connect Index Futures
Contract Multiplier US$25 2022 | 2023 |
Notional Value (1 Contract) US$0.05Mn (As at 31 October 2023) Open Interest (as of 31 October 2023)

Average Quote Size US$0.24Mn (5 Contracts)
Open Interest
(No. of Contracts)

25,000 -
Transaction Cost*
Stamp Duty N/A 20,000 -
Trading Fee US$0.5 / contract
15,000 -
SFC Levy US$0.07 / contract
Margin as of 30 Oct 2023 US$2,790 10,000 > olec 2 = = = - = o a =
© o > o
2 &8/S 2 =< £ 3> 2 & O
2022 | 2023 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 October 2023



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$45K (As at 31 October 2023)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 October 2023

Open Interest (As of 31 October 2023)

Open Interest
(No. of Contracts)

100,000 ~
90,000 -
80,000 -
70,000 -
60,000
2 Qg 9 &5 5 2> £ 3 © 2 O
2 a8 & =< £ 3 2 &8 o
2022 | 2023 |
Average Daily Volume (As of October 2023)
ADV
(No. of Contracts)
30,000 -
20,000 -
10,000 -
0 -
> (&)
o (3]
ZzZ 0
2022 2023

Volume and Open Interest continue to growth

12



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEI Correlation (2023)

MSCI AxJ Futures

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

466.65 (As at 31 October 2023)
14.9

4.48 (October 2023)

0.911

0.901

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$47K (As at 31 October 2023)
US$0.23Mn (5 Contracts)

1.0 index points (October 2023)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 30 Oct 2023

N/A
US$0.5 / contract
US$0.07 / contract

US$1,900

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 31 October 2023

Open Interest (31 October 2023)

Open Interest
(No. of Contracts)

1,200 -

1,000 -

800 -

600 -

400 -

200 -

0
> 9/lc 2 5 5 > c 3 © o B
2z o|s & =<2 3 ° 2 § O
2022| 2023 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCIAXJ e MSCI China MSCI HK
120 - MSCISG o MSClInda MSCI Indonesia
----------------- MSCI Korea e MSCI Malaysia MSCI Pakistan
----------------- MSCI Philippines - MSCI Taiwan MSCI Thailand
110 -
100
90
80 . .
Aug-2023 Sep-2023 Oct-2023

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

5-Min Avg. Bid-Ask Spreads (31 October 2023)

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEIl Correlation (2023)

10 largest and most representative
HKEX-listed mainland banks stocks

2,281.47 (As at 31 October 2023)
26.9

26.55 (October 2023)

0.763

0.775

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 30 Oct 2023

HK$50

HK$0.11Mn (As at 31 October 2023)
HK$0.57Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$5,960

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 October 2023

HSMBI Futures
CEB Bank 6818.HK
Minsheng Bank 1988.HK
ABC 1288.HK
Bank of China 3988.HK

ICBC 1398.HK

PSBC 1658.HK
CITIC Bank 998.HK

Bankcomm 3328.HK
CM Bank 3968.HK

0.49%
0.47%

CCB 939.HK

Index & Constituents 3-Month Performance (Rebased to 100)

120 -

110

100

90

80
Aug

———HSMBI
ICBC (1398.HK)
——ABC (1288.HK)

——CCB (939.HK)
BOC (3988.HK)

-2023

Sep-2023 Oct-2023

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (31 October 2023)

80 A-Shares and 40 HK-listed Mainland

Index Description ) ) )
China H-shares, P-chips, and red chips

CES120 Futures | N/A
Index Level 5,176.72 (As at 31 October 2023)

Index Volatility (30-Day Historical) | 18.7

esorerse anere ez [ o

Index Avg. Day High-Low Range 48.47 (October 2023)

CSI300 Correlation (2023) 0.879

crinavc csooere arsar) [T o=
FTSE A50 Correlation (2023) 0.887

i 0,

p— X Stares 60 ETF (2823 — 0i1%
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.26Mn (As at 31 October 2023)
Average Quote Size HK$1.29Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)
Average Bid-Ask Trading Spread| N/A

120 e=CES120 Index Tencent CcCB
Liquidity Providers N/A ——Ping An ——— China Mobile
110 -
Transaction Cost* 100
Stamp Duty N/A 90
Trading Fee HK$5 / contract
80
SFC Levy HK$0.54 / contract
1 70 T T 1
M f 202 HK$1
argin as of 30 Oct 2023 $13,560 Aug-2023 Sep-2023 Oct-2023
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 October 2023



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan  |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



